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Choose (click on) any option below that meets your current need. 

Afterwards, scroll back to the top (here) to pick another option. 

Maybe you should glance at the Introduction first.  It’s not long. 
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GanttProject: Start Guide 
 

Create a Gantt chart to plan and monitor a schedule and its resources  

 

 

 

Before You Start  

You will first need to install GanttProject.  To 

begin, use your web browser to navigate to 

http://www.ganttproject.biz 

 

 

Then you will need to download and install 

GanttProject ver. 2.8.7 or later. To do this, click 

on the download icon in the upper left corner of 

the page. 

 

 

 

1. Choose Free download  

2. Choose Download GanttProject   

3. Choose Windows (on the left of webpage)  

4. Choose Download (yes, again)  

5. Run the downloaded file 

 

If the program does not open once installed make 

sure you have updated Java Runtime installed on 

your computer. You may also find links to help with 

this at the following web address: 

http://www.ganttproject.biz/discuss  

 

 

 

Step 1  

Launch the program by clicking 

on the newly installed 

GanttProject icon on the desktop.   

 

Permit Java to update if need be. 

 

Then, in the menubar, click Project > New to open 

a Create new project window. 
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Step 2  

Type the name of your project. At this time you 

may also elect to type in the name of your 

organization, a web link, and a description.  

 

Then select (click on) Ok. 

 

 

 

 

Step 3  

Determine how many tasks in your project list (7).  

From the menubar, choose Tasks > New task 

for each task you expect to add.  (Or else, in the 

toolbar, click New Task or right-click on the table 

space and choose New Task.) 

 

 

Step 4  

Highlight all of the tasks below task_0: 

First click on Task_1.  Then hold down “Shift” 

and click on the last task. 

 

 

Step 5  

Right click the highlighted area with your mouse 

pointer and then click on Indent.  All the task 

names except task_0 will be indented. 

 

Step 6  

Double click on the term task_0 so that it 

becomes editable.  Then rename task_0 with the 

project name (Project 2).  Press [Enter] 

  



 

 

 

 

Step 7  

Double click on each task name in turn and 

rename it with a description of the task.  See all 

the descriptions at left. 

 

 

 

 

 

Step 8  

Task bars are the long grey 

rectangles to the right of each task 

name.  Click and drag from each 

task bar to the one below, creating 

a black arrow from the upper bar 

to the task below. This shows the 

start of a following task to be 

dependent upon the completion of 

its preceding task. 

 

 

Step 9  

Right-click on a task and click Task properties… 

to open a Properties dialog box, then estimate 

and type the duration (time needed to complete 

the task).   

 

Click Ok to close the box.  

 

Do this for each indented task.  Use small 

numbers. 

 

 

 

 

Step 10  

Select (click on) the Resources Chart tab. 

 

  



Step 11  

On the menubar, click Resources > New 

Resource to open a dialog box. Enter the 

resource name and any additional information 

of your choice. Then select the Ok button to 

close the dialog box.  

 

Repeat for three additional resources.  Make 

up your own details. 

 

 

 

 

Step 12  

If need be, select the Gantt tab to get back to the 

task list. 

 

 

 

 

Step 13  

Now on the Gantt tab, right-click a task and 

choose Task Properties… to open the Properties 

dialog box. In the dialog box, select the 

Resources tab.  

 

 

Step 14  

Click the Add button and use the drop down list to assign a resource to this task. Select the Ok 

button to close the dialog box. Add resources for all of your tasks.  

 

 
  



Congratulations! 

You have created and populated a Gantt chart 

to plan and track the progress of the project 

 

 
 

 

Based on ENGL-334_Project-2_GP-Quick-Guide_KVensland.pdf by Kent Vensland 

 

  



From:  https://project-management.com/top-5-open-source-project-management-tools/  

 

GanttProject: Review 
 

 

Developed in Java as a compact, high-performance Project Management tool, GanttProject strictly 

follows MS Windows’ look and feel.  It has limited function features, which works to its advantage 

because it incorporates features of MS Project but with a focus on features having maximum use. 

 

 
 

Features 

Gantt Project is GPL open source software that offers project scheduling as its main function. 

Working on a desktop-client architecture, this file based project management tool allows not just 

scheduling of tasks, but resource management as well, through resource load charts. It supports 

MS Project, PDF, CSV and HTML file types. 

 

Technical Requirements 

Supported by Windows, Mac OS and UNIX / Linux systems and available in 30 languages 

 

Advantages 

 Excellent and easy to use with a great user interface  

 Simplified MS Gantt-chart ‘drawing’ features  

 Allows great scope for Baselining  

 A great number of reporting options  

 Data exchange is seamless across spreadsheet applications  

 

Disadvantages 

 The main feature that one would want to add is a clear feature for resource levelling and 

critical path visualization, but this is an additional level of complexity. 
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From:  http://www.ganttproject.biz/  

 

GanttProject: Website snippets 
 

Gantt chart 
 Create tasks and milestones. Aside from the Begin date 

and duration, every task may have priority, cost, colour 

and fill pattern, text notes and user-defined custom fields.  

 Organize tasks in a work breakdown structure (WBS). 

Hierarchical tree where progress, dates or costs of lower 

level tasks is summarized on the higher levels. Summary 

tasks can be collapsed to hide tasks which are not 

important at the moment.  

 Draw dependency constraints between tasks, like "start 

X when Y finishes" and GanttProject will take care of 

enforcing these constraints. You can add a lag (delay) or 

use other types of constraints.  

 Create baselines to be able to compare current project state with previous plans.  

 PERT chart for read-only view can be generated from the Gantt chart.  

 

 

Resource chart 
 Create human resources with the basic contact 

information, payment rate and role.  

 Assign resources to work on tasks with different roles 

and assignment units.  

 Monitor task assignments and see when some 

resource gets overloaded or is sitting without work.  

 

 

 

Export 
 Generate a PDF report with a summary, required task 

and resource information and vector chart images  

 PNG/JPEG images can be generated from individual 

charts and printed  

 Export to CSV to analyse your data in spreadsheet apps. 

Import from CSV is also supported  

 Microsoft Project import and export, as smooth as 

possible  

 Project calendar import from iCalendar format   

 

Collaboration 
 Use WebDAV servers with locks support for concurrent work on the same project.  

 Use cloud storage providers which can mount your cloud disk to your local file system for 

storing your projects in the cloud  

 On the local network GanttProject will do its best to prevent concurrent writes  

  

http://www.ganttproject.biz/
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From:  https://docs.ganttproject.biz/releases/ 

 

GanttProject: Release notes 
 

Headlines (ver.2.8.7) 

The major new feature is actually a pretty old one which has been made to work. We had a so called 

"additional constraint" called early begin in task properties for years, and its meaning was pretty vague, 

mostly because this constraint didn’t work. 

 

As of version 2.8 this constraint now works and it has clear semantics: a task with an early Begin constraint 

set to some date X will be scheduled to start no earlier than X and as close to X as possible, provided that 

other constraints permit that. 

 

The obvious use of this constraint is to set the earliest date when a task can start. For instance, if task begin 

date was set on July 5 then changing its earliest start constraint to July 14 will move task to the future. 

 

However, there is another use case which is now possible: you can use it as "planned start date", as 

opposed to the real start date set by the scheduler. If task had initially start date and earliest start constraint 

set to July 14, and was moved to some later date because of finish-start dependencies on other tasks then 

removing the dependencies will move the task back to July 14. 

 

Scheduler Audit and Report 

Since the Early Begin constraint is now enforced, 

older projects where it was set and probably 

forgotten may be affected. When opening older 

projects GanttProject audits the first run of the 

scheduler and reports the results to user if at least 

one task changes its dates after the first run. 

Scheduler Report looks as shown: 

 

If your project is fine and the scheduler has made no 

changes, you’ll see no report. Otherwise the report 

shows up a couple of seconds after file has been 

opened and you need to inspect the changes made 

by the scheduler. 

 

Other changes 

   Maintenance updates fixed most of High-DPI compatibility issues and added a new feature: sorting of 

tasks by begin/end dates 

 

Compatibility 

File format has slightly changed: we removed redundant information about the configuration columns shown 

in the task table. Files produced by GanttProject 2.7 should open fine in GanttProject 2.8. Files produced by 

GanttProject 2.8 can be opened in GanttProject 2.7, except that only Name, Begin date and End date 

columns will be shown in the task table by default, no matter what is written in the project file. 

 

System requirements 

 Any reasonably modern computer with reasonably modern OS capable of running Java applications 

is fine for running GanttProject.  

 We recommend using Java 8 for running GanttProject, but Java 7 is also fine. 

 Android and iOS are not supported. 

 You may have issues when running GanttProject on systems with high-density displays. 

  

https://docs.ganttproject.biz/releases/
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From:  https://docs.ganttproject.biz/user/scheduler/index.html 

 

GanttProject: Scheduler explained  
 

Note: This article explains various aspects of task scheduling in GanttProject which may (or may not) affect 

task start dates. 

 

The scheduling algorithm in GanttProject, referred hereafter as the Scheduler, takes decisions on task start 

dates taking into account various constraints, with the ultimate goal to make the duration of the whole project 

as short as possible. The Scheduler continuously runs after every change in the project and updates tasks 

appropriately. 

 

The Scheduler tries to be logical and unobtrusive, however it may move some tasks or may reject your 

updates to the task schedule and it is important to understand its decisions. 

 

Simple unconstrained task 

A simple task which is created by default with the Task.New task action is scheduled to the date set by the 

user. Default date is the start of the timeframe which is currently shown on the chart. You can change the 

start date using task table or task properties dialog and you can choose any date as the start date, with the 

only exception that you can’t by default schedule a task on a weekend or holiday. 

 

Earliest begin constraint 

A task which has non-empty constraint Earliest begin can’t be started earlier than the date specified in the 

constraint and will be scheduled as close to that date as possible. It may start later than that date if other 

constraints decide so. However if there are no other constraints, the Scheduler will force the task to start at 

the specified Earliest begin date. 

 

Note: New in GanttProject 2.8. Earliest begin constraint existed but was mostly ignored until GanttProject 

2.8 release. In GanttProject 2.8, however, it was fixed, and this change may affect older projects. 

 

Summary task 

A task which groups one or more other tasks is called a Summary task or Supertask. Provided that there 

are no other constraints, the Begin date, End date and duration of a summary task are calculated from the 

dates of its child tasks. The duration of a summary task is always the difference between the earliest start 

and latest end of its child tasks. 

 

Note: New in GanttProject 2.8. Prior to GanttProject 2.8 scheduling properties of summary tasks were 

technically editable in the UI, despite that any edits would be immediately reverted by the Scheduler. 

In GanttProject 2.8 start/end dates and duration of summary tasks are not editable anymore. 

 

Dependency constraints 

You can create links, or dependencies, between tasks and the Scheduler will take them into account. The 

simplest and most frequently used dependency is Finish-Start dependency which says that successor task 

can’t start earlier than predecessor task finishes. In some cases though, the successor task may start a few 

days later. Other constraints are: Finish-Finish, Start-Start and Start-Finish.  

 

In general a constraint written in the form <PredecessorDoesThis>-<SuccessorDoesThat> reads as: 

 

 In the absence of other constraints:  

date when SuccessorDoesThat minus date when PredecessorDoesThis = lag time. 

 

When Scheduler considers some task, it scans through all dependencies where that task plays the role of 

successor and chooses the earliest start date which satisfies all dependency constraints. 

 

https://docs.ganttproject.biz/user/scheduler/index.html
https://docs.ganttproject.biz/releases
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Lag (delay) time 

The default value is 0, which can be changed to both positive and negative values, so that, for example, you 

can have a task which starts one day before its predecessor ends. 

 

Hardness 

Hardness is actually equality or inequality comparison in the formula above. Strong hardness is equivalent to 

= while rubber is equivalent to >=. In practice it means that, for rubber dependencies, lag between successor 

and predecessor is allowed to grow bigger than the specified lag (delay) value, e.g. when the predecessor 

moves backwards in time, successor will stay where it is, other constraints permitting. 

 

Summary task as successor 

When a summary task itself has a dependency and plays the role of successor, the Scheduler creates 

implicit dependencies of the same type and with the same properties to all its child tasks. This may have 

consequences which look pretty natural when seen, but which are not exposed. If we consider Finish-Start 

dependency where successor is a summary task then no child of that task can start earlier than predecessor 

finishes, and any changes in the child task dates which violate this will be rejected. However, from user 

perspective it may look as if GanttProject rejects moving a task to an earlier start date for no reason. 

 

 

  



From:  https://en.wikipedia.org/wiki/Gantt_chart  

 

Gantt chart 
From Wikipedia, the free encyclopedia 

 

 

A Gantt chart is a type of bar chart that 

illustrates a project schedule. Modern 

Gantt charts also show the dependency 

relationships between activities and 

current schedule status. 

 
A Gantt chart showing three kinds of schedule 

dependencies (in red) and percent complete 

indications. 

Definition 

A Gantt chart is a type of bar chart that illustrates a project schedule.  This chart lists the tasks to 

be performed on the vertical axis, and time intervals on the horizontal axis. The lengths of the 

horizontal bars in the graph show the duration of each activity.  Gantt charts illustrate the start and 

finish dates of the terminal elements and summary elements of a project. Terminal elements and 

summary elements constitute the work breakdown structure of the project. Modern Gantt charts 

also show the dependency (i.e., precedence network) relationships between activities. Gantt charts 

can be used to show current schedule status using percent-complete shadings and a vertical 

"TODAY" line, as shown above. 

 

Gantt charts are usually created initially using an early start time approach, where each task is 

scheduled to start immediately when its prerequisites are complete. This method maximizes the 

float time available for all tasks.  

 

 

Historical development 

The chart is named after Henry Gantt (1861–1919), who designed his chart around the years 

1910–1915.  The earliest Gantt charts were drawn on paper and therefore had to be redrawn 

entirely in order to adjust to schedule changes. In the 1980s, personal computers allowed 

widespread creation of complex and elaborate Gantt charts. The first desktop applications were 

intended mainly for project managers and project schedulers.  By 2012, almost all Gantt charts 

were made by software which can easily adjust to schedule changes.  In 1999, Gantt charts were 

identified as "one of the most widely used management tools for project scheduling and control". 

 

 

Example 

In the following table there are seven tasks, labelled a to g. Some tasks can be done concurrently 

(a and b) while others cannot be done until their predecessor task is complete (c and d cannot 

begin until a is complete). Additionally, each task has three time estimates: the optimistic time 

estimate (O), the most likely or normal time estimate (M), and the pessimistic time estimate (P). 

The expected time (TE) is estimated using the beta probability distribution for the time estimates, 

using the formula (O + 4M + P) ÷ 6. 

 

 

https://en.wikipedia.org/wiki/Gantt_chart
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https://en.wikipedia.org/wiki/Project
https://en.wikipedia.org/wiki/Work_breakdown_structure
https://en.wikipedia.org/wiki/Dependency_(project_management)
https://en.wikipedia.org/wiki/Float_(project_management)
https://en.wikipedia.org/wiki/Beta_distribution#Project_management:_task_cost_and_schedule_modeling


Activity Predecessor 
Time estimates 

Expected time (TE) 
Opt. (O) Normal (M) Pess. (P) 

a — 2 4 6 4.00 

b — 3 5 9 5.33 

c a 4 5 7 5.17 

d a 4 6 10 6.33 

e b, c 4 5 7 5.17 

f d 3 4 8 4.50 

g e 3 5 8 5.17 

 

Once this data is complete, one can draw a Gantt chart or a network diagram. 

 

 
A Gantt chart created using Microsoft Project (MSP). Note (1) the critical path is in red, (2) the slack is the black lines 

connected to non-critical activities, (3) since Saturday and Sunday are not work days and are thus excluded from the 

schedule, some bars on the Gantt chart are longer if they cut through a weekend. 

 

Progress Gantt charts 

In a progress Gantt chart, tasks are shaded in proportion to the degree of their completion. In other 

words, a task that is 60% complete would be 60% shaded, starting from the left. A vertical line is 

drawn at the current time index when the progress Gantt chart is created, and this line can then be 

compared with shaded tasks. If everything is on schedule, all task portions left of the line will be 

shaded, and all task portions right of the line will not be shaded. This provides a visual 

representation of how the project and its tasks are ahead of or behind schedule.  

 

Linked Gantt charts 

Linked Gantt charts contain lines indicating the dependencies between tasks. However, linked 

Gantt charts quickly become cluttered in all but the simplest cases. Critical path network diagrams 

are superior to visually communicate the relationships between tasks.  However, Gantt charts are 

often preferred over network diagrams because Gantt charts are easily interpreted without training, 

whereas critical path diagrams require training to interpret.  Gantt chart software typically provides 

mechanisms to link task dependencies, although this data may or may not be visually represented.  

Gantt charts and network diagrams are often used for the same project, both being generated from 

the same data by a software application. 

 

(GanttProject provides for the creation of linked Gantt charts.) 
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From:  https://en.wikipedia.org/wiki/Program_evaluation_and_review_technique 

 

PERT (Project Evaluation and Review Technique) 
From Wikipedia, the free encyclopaedia 

 

 

 
PERT network chart for a seven-month project with 

five milestones (10 through 50) and six activities (A 

through F). 

 

 

 

 

The program (or project) evaluation and review technique, commonly abbreviated PERT, is a 

statistical tool, used in project management, which was designed to analyse and represent the 

tasks involved in completing a given project.  It is commonly used in conjunction with the critical 

path method (CPM). 

 

Overview 

Project Evaluation and Review Technique is commonly abbreviated to PERT. PERT is a method of 

analyzing the tasks involved in completing a given project, especially the time needed to complete 

each task, and to identify the minimum time needed to complete the total project. It incorporates 

uncertainty by making it possible to schedule a project while not knowing precisely the details and 

durations of all the activities. It is more of an event-oriented technique rather than start- and 

completion-oriented, and is used more in projects where time is the major factor rather than cost. It 

is applied to very large-scale, one-time, complex, non-routine infrastructure and Research and 

Development projects. 

 

Program Evaluation Review Technique (PERT) offers a management tool, which relies "on arrow 

and node diagrams of activities and events: arrows represent the activities or work necessary to 

reach the events or nodes that indicate each completed phase of the total project." 

 

PERT and CPM are complementary tools, because "CPM employs one time estimate and one cost 

estimate for each activity; PERT may utilize three time estimates (optimistic, expected, and 

pessimistic) and no costs for each activity. Although these are distinct differences, the term PERT 

is applied increasingly to all critical path scheduling." 

 

The technique is a management control tool that sizes up the outlook for meeting objectives on 

time; highlights danger signals requiring management decisions; reveals and defines both 

methodicalness and slack in the flow plan or the network of sequential activities that must be 

performed to meet objectives; compares current expectations with scheduled completion dates and 

computes the probability for meeting scheduled dates; and simulates the effects of options for 

decision – before decision. 

 

For the subdivision of work units in PERT another tool was developed: the Work Breakdown 

Structure. The Work Breakdown Structure provides a framework for complete networking. the 

Work Breakdown Structure was introduced as the first item of analysis in carrying out basic PERT. 
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Terminology 

 

Events and activities 

In a PERT diagram, the main building block is the event, with connections to its known 

predecessor events and successor events. 

 PERT event: a point that marks the start or completion of one or more activities. It 

consumes no time and uses no resources. When it marks the completion of one or more 

activities, it is not "reached" (does not occur) until all of the activities leading to that event 

have been completed. 

 predecessor event: an event that immediately precedes some other event without any other 

events intervening. An event can have multiple predecessor events and can be the 

predecessor of multiple events. 

 successor event: an event that immediately follows some other event without any other 

intervening events. An event can have multiple successor events and can be the successor 

of multiple events. 

Besides events, PERT also knows activities and sub-activities: 

 PERT activity: the actual performance of a task which consumes time and requires 

resources (such as labor, materials, space, machinery). It can be understood as 

representing the time, effort, and resources required to move from one event to another. A 

PERT activity cannot be performed until the predecessor event has occurred. 

 PERT sub-activity: a PERT activity can be further decomposed into a set of sub-activities. 

For example, activity A1 can be decomposed into A1.1, A1.2 and A1.3. Sub-activities have 

all the properties of activities; in particular, a sub-activity has predecessor or successor 

events just like an activity. A sub-activity can be decomposed again into finer-grained sub-

activities. 

Time 

PERT has defined four types of time required to accomplish an activity: 

 optimistic time: the minimum possible time required to accomplish an activity (o) or a path 

(O), assuming everything proceeds better than is normally expected 

 pessimistic time: the maximum possible time required to accomplish an activity (p) or a path 

(P), assuming everything goes wrong (but excluding major catastrophes). 

 most likely time: the best estimate of the time required to accomplish an activity (m) or a 

path (M), assuming everything proceeds as normal. 

 expected time: the best estimate of the time required to accomplish an activity (te) or a path 

(TE), accounting for the fact that things don't always proceed as normal (the implication 

being that the expected time is the average time the task would require if the task were 

repeated on a number of occasions over an extended period of time). 

 

te = (o + 4m + p) ÷ 6 

 

Management tools 
 

PERT supplies a number of tools for management with determination of concepts, such as: 

 float or slack is a measure of the excess time and resources available to complete a task. It 

is the amount of time that a project task can be delayed without causing a delay in any 

subsequent tasks (free float) or the whole project (total float). Positive slack would indicate 

ahead of schedule; negative slack would indicate behind schedule; and zero slack would 

indicate on schedule. 

https://en.wikipedia.org/wiki/Float_(project_management)
https://en.wikipedia.org/wiki/Float_(project_management)


 critical path: the longest possible continuous pathway taken from the initial event to the 

terminal event. It determines the total calendar time required for the project; and, therefore, 

any time delays along the critical path will delay the reaching of the terminal event by at 

least the same amount. 

 critical activity: An activity that has total float equal to zero. An activity with zero float is not 

necessarily on the critical path since its path may not be the longest. 

 lead time: the time by which a predecessor event must be completed in order to allow 

sufficient time for the activities that must elapse before a specific PERT event reaches 

completion. 

 lag time: the earliest time by which a successor event can follow a specific PERT event. 

 fast tracking: performing more critical activities in parallel 

 crashing critical path: Shortening duration of critical activities 

 

 

  

https://en.wikipedia.org/wiki/Critical_path_method
https://en.wiktionary.org/wiki/lead#Verb_2
https://en.wikipedia.org/wiki/Critical_path_method
https://en.wikipedia.org/wiki/Critical_path_method


From:  https://en.wikipedia.org/wiki/Critical_path_method  

 

CPM (Critical path method) 
From Wikipedia, the free encyclopedia 

 
PERT chart for a project with five milestones (10 through 50) 

and six activities (A through F). The project has two critical 

paths: activities B and C, or A, D, and F – giving a minimum 

project time of 7 months with fast tracking. Activity E is sub-

critical, and has a float of 1 month. 

 

 

The critical path method (CPM), or critical path analysis (CPA), is an algorithm for scheduling a 

set of project activities.  It is commonly used in conjunction with the program evaluation and review 

technique (PERT). 

 

Basic technique 
 

Components 

In using CPM, The essential technique is to construct a model of the project that includes the 

following: 

1. A list of all activities required to complete the project (typically categorized within a work 

breakdown structure), 

2. The time (duration) that each activity will take to complete, 

3. The dependencies between the activities and, 

4. Logical end points to each activity such as milestones or deliverable items. 

 

Using these values, CPM calculates the longest path of planned activities to logical end points or to 

the end of the project, and the earliest and latest that each activity can start and finish without 

making the project longer. This process determines which activities are "critical" (i.e., on the 

longest path) and which have "total float" (i.e., can be delayed without making the project longer). 

In project management, a critical path is the sequence of project network activities which add up to 

the longest overall duration, regardless if that longest duration has float or not. This determines the 

shortest time possible to complete the project. There can be 'total float' (unused time) within the 

critical path. For example, if a project is testing a solar panel and task 'B' requires 'sunrise', there 

could be a scheduling constraint on the testing activity so that it would not start until the scheduled 

time for sunrise. This might insert dead time (total float) into the schedule on the activities on that 

path prior to the sunrise due to needing to wait for this event. This path, with the constraint-

generated total float would actually make the path longer, with total float being part of the shortest 

possible duration for the overall project. In other words, individual tasks on the critical path prior to 

the constraint might be able to be delayed without elongating the critical path; this is the 'total float' 

of that task. However, the time added to the project duration by the constraint is actually critical 

path drag, the amount by which the project's duration is extended by each critical path activity and 

constraint. 

 

A project can have several, parallel, near critical paths; and some or all of the tasks could have 

'free float' and/or 'total float'. An additional parallel path through the network with the total durations 

shorter than the critical path is called a sub-critical or non-critical path. Activities on sub-critical 

paths have no drag, as they are not extending the project's duration. 
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CPM analysis tools allow a user to select a logical end point in a project and quickly identify its 

longest series of dependent activities (its longest path). These tools can display the critical path 

(and near critical path activities if desired) as a cascading waterfall that flows from the project's 

start (or current status date) to the selected logical end point. 

 

Visualizing critical path schedule 
 

Although the activity-on-arrow diagram (PERT Chart) is still used in a few places, it has generally 

been superseded by the activity-on-node diagram, where each activity is shown as a box or node 

and the arrows represent the logical relationships going from predecessor to successor as shown 

here in an "Activity-on-node diagram". 

 

Activity-on-node diagram showing 

critical path schedule, along with 

total float and critical path drag 

computations 

 

 

In this diagram, Activities A, B, C, 

D, and E comprise the critical or 

longest path, while Activities F, G, 

and H are off the critical path with 

floats of 15 days, 5 days, and 20 

days respectively. Whereas 

activities that are off the critical 

path have float and are therefore 

not delaying completion of the project, those on the critical path will usually have critical path drag, 

i.e., they delay project completion. The drag of a critical path activity can be computed using the 

following formula: 

 

1. If a critical path activity has nothing in parallel, its drag is equal to its duration. Thus A and E 

have drags of 10 days and 20 days respectively. 

2. If a critical path activity has another activity in parallel, its drag is equal to whichever is less: 

its duration or the total float of the parallel activity with the least total float. Thus since B and 

C are both parallel to F (float of 15) and H (float of 20), B has a duration of 20 and drag of 

15 (equal to F's float), while C has a duration of only 5 days and thus drag of only 5. Activity 

D, with a duration of 10 days, is parallel to G (float of 5) and H (float of 20) and therefore its 

drag is equal to 5, the float of G. 

 

These results, including the drag computations, allow managers to prioritize activities for the 

effective management of project completion, and to shorten the planned critical path of a project by 

pruning critical path activities, by "fast tracking" (i.e., performing more activities in parallel), and/or 

by "crashing the critical path" (i.e., shortening the durations of critical path activities by adding 

resources). 

 

Critical path drag analysis has also been used to optimize schedules in processes outside of strict 

project-oriented contexts, such as to increase manufacturing throughput by using the technique 

and metrics to identify and alleviate delaying factors and thus to reduce assembly lead time. 
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Work Breakdown 

Structure (WBS) 
From Wikipedia, the free encyclopedia 

 

 
Example from MIL-HDBK-881, 

illustrating the first three levels of a 

typical aircraft system. 

 

 

 

 

 

 

A work-breakdown structure (WBS), also referred to as "contract work-breakdown structure" 

or "CWBS", in project management and systems engineering, is a deliverable-oriented breakdown 

of a project into smaller components.  A work breakdown structure is a key project deliverable that 

organizes the team's work into manageable sections. The document, Project Management Body of 

Knowledge, defines the work-breakdown structure as a "A hierarchical decomposition of the total 

scope of work to be carried out by the project team to accomplish the project objectives and create 

the required deliverables." 

 

A work-breakdown structure element may be a product, data, service, or any combination thereof. 

A WBS also provides the necessary framework for detailed cost estimating and control along with 

providing guidance for schedule development and control.[3] 

 

Overview 
WBS is a hierarchical and incremental decomposition of the project into phases, deliverables and 

work packages. It is a tree structure, which shows a subdivision of effort required to achieve an 

objective; for example a program, project, and contract.  In a project or contract, the WBS is 

developed by starting with the end objective and successively subdividing it into manageable 

components in terms of size, duration, and responsibility (e.g., systems, subsystems, components, 

summary tasks, tasks, and work packages) which include all steps necessary to achieve the 

objective. 

 

 

 
Example of work breakdown structure applied in a NASA 

reporting structure.  

 

 

 

 

 

The work-breakdown structure provides a common framework for the natural development of the 

overall planning and control of a contract and is the basis for dividing work into definable 

increments from which the statement of work can be developed and technical, schedule, cost, and 

labour hour reporting can be established. 
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A work breakdown structure permits summing of subordinate costs for tasks, materials, etc., into 

their successively higher level "parent" tasks, materials, etc. For each element of the work 

breakdown structure, a description of the task to be performed is generated.[5] This technique 

(sometimes called a system breakdown structure[6]) is used to define and organize the total scope 

of a project. 

 

The WBS is organized around the primary products of the project (or planned outcomes) instead of 

the work needed to produce the products (planned actions). Since the planned outcomes are the 

desired ends of the project, they form a relatively stable set of categories in which the costs of the 

planned actions needed to achieve them can be collected. A well-designed WBS makes it easy to 

assign each project activity to one and only one terminal element of the WBS. In addition to its 

function in cost accounting, the WBS also helps map requirements from one level of system 

specification to another, for example a requirements cross reference matrix mapping functional 

requirements to high level or low level design documents. The WBS may be displayed horizontally 

in outline form, or vertically as a tree structure (like an organization chart). 

 

The development of the WBS normally occurs at the start of a project and precedes detailed 

project and task planning. 

 

Design principles 
 

100% rule 

An important design principle for work breakdown structures is called the 100% rule.[14] It has been 

defined as follows: 

 

The 100% rule states that the WBS includes 100% of the work defined by the project scope and 

captures all deliverables – internal, external, interim – in terms of the work to be completed, 

including project management. The 100% rule is one of the most important principles guiding the 

development, decomposition and evaluation of the WBS. The rule applies at all levels within the 

hierarchy: the sum of the work at the "child" level must equal 100% of the work represented by the 

"parent" and the WBS should not include any work that falls outside the actual scope of the project, 

that is, it cannot include more than 100% of the work.  It is important to remember that the 100% 

rule also applies to the activity level. The work represented by the activities in each work package 

must add up to 100% of the work necessary to complete the work package. 

 

Mutually exclusive elements 

Mutually exclusive: In addition to the 100% rule, it is important that there is no overlap in scope 

definition between different elements of a work breakdown structure. This ambiguity could result in 

duplicated work or miscommunications about responsibility and authority. Such overlap could also 

cause confusion regarding project cost accounting. If the WBS element names are ambiguous, a 

WBS dictionary can help clarify the distinctions between WBS elements. The WBS Dictionary 

describes each component of the WBS with milestones, deliverables, activities, scope, and 

sometimes dates, resources, costs, quality. 

 

Plan outcomes, not actions 

If the work breakdown structure designer attempts to capture any action-oriented details in the 

WBS, the designer will likely include either too many actions or too few actions. Too many actions 

will exceed 100% of the parent's scope and too few will fall short of 100% of the parent's scope. 

The best way to adhere to the 100% rule is to define WBS elements in terms of outcomes or 

https://en.wikipedia.org/wiki/Work_breakdown_structure#cite_note-5
https://en.wikipedia.org/wiki/Work_breakdown_structure#cite_note-6
https://en.wikipedia.org/wiki/Scope_(project_management)
https://en.wikipedia.org/wiki/Project
https://en.wikipedia.org/wiki/Outline_(list)
https://en.wikipedia.org/wiki/Work_breakdown_structure#cite_note-14
https://en.wikipedia.org/wiki/Mutually_exclusive
https://en.wikipedia.org/wiki/Milestone_(project_management)
https://en.wikipedia.org/wiki/Resource_(project_management)


results, not actions. This also ensures that the WBS is not overly prescriptive of methods, allowing 

for greater ingenuity and creative thinking on the part of the project participants. For new product 

development projects, the most common technique to ensure an outcome-oriented WBS is to use 

a product breakdown structure. Feature-driven software projects may use a similar technique 

which is to employ a feature breakdown structure. When a project provides professional services, a 

common technique is to capture all planned deliverables to create a deliverable-oriented WBS. 

Work breakdown structures that subdivide work by project phases (e.g. preliminary design phase, 

critical design phase) must ensure that phases are clearly separated by a deliverable also used in 

defining entry and exit criteria (e.g. an approved preliminary or critical design review). 

 

Level of detail 

One must decide when to stop dividing work into smaller elements. This will assist in determining 

the duration of activities necessary to produce a deliverable defined by the WBS. There are several 

heuristics or "rules of thumb" used when determining the appropriate duration of an activity or 

group of activities necessary to produce a specific deliverable defined by the WBS. 

 The first is the "80 hour rule" which means that no single activity or group of activities at the 

lowest level of detail of the WBS to produce a single deliverable should be more than 80 

hours of effort. 

 The second rule of thumb is that no activity or group of activities at the lowest level of detail 

of the WBS should be longer than a single reporting period. Thus if the project team is 

reporting progress monthly, then no single activity or series of activities should be longer 

than one month long. 

 The last heuristic is the "if it makes sense" rule. Applying this rule of thumb, one can apply 

"common sense" when creating the duration of a single activity or group of activities 

necessary to produce a deliverable defined by the WBS. 

 

A work package at the activity level is a task that: 

 can be realistically and confidently estimated; 

 makes no sense practically to break down any further; 

 can be completed in accordance with one of the heuristics defined above; 

 produces a deliverable which is measurable; and 

 forms a unique package of work which can be outsourced or contracted out. 

 

Consistent to norms 

The higher WBS structure should be consistent to whatever norms or template mandates exist 

within the organization or domain. For example, shipbuilding for the U.S. Navy must respect that 

the nautical terms and their hierarchy structure put into MIL-STD are embedded in Naval 

Architecture and that matching Navy offices and procedures have been built to match this naval 

architecture structure, so any significant change of WBS element numbering or naming in the 

hierarchy would be unacceptable. 

 

Coding scheme 

It is common for work breakdown structure elements to be numbered sequentially to reveal the 

hierarchical structure. The purpose for the numbering is to provide a consistent approach to 

identifying and managing the WBS across like systems regardless of vendor or service. For 

example, 1.1.2 Propulsion (in the example below) identifies this item as a Level 3 WBS element, 

since there are three numbers separated by a decimal point. A coding scheme also helps WBS 

elements to be recognized in any written context and allows for mapping to the WBS Dictionary. 
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A practical example of a WBS coding scheme is: 

 

1.0 Aircraft System 

1.1 Air Vehicle  

1.1.1 Airframe  

1.1.1.1 Airframe Integration, Assembly, Test and Checkout 

1.1.1.2 Fuselage 

1.1.1.3 Wing 

1.1.1.4 Empennage 

1.1.1.5 Nacelle 

1.1.1.6 Other Airframe Components 1..n (Specify) 

1.1.2 Propulsion 

1.1.3 Vehicle Subsystems 

1.1.4 Avionics 

1.2 System Engineering 

1.3 Program Management 

1.4 System Test and Evaluation 

1.5 Training 

1.6 Data 

1.7 Peculiar Support Equipment 

1.8 Common Support Equipment 

1.9 Operational/Site Activation 

1.10 Industrial Facilities 

1.11 Initial Spares and Repair Parts 

 

Terminal element 

This is the lowest element in a tree structure, a terminal element is one that is not further 

subdivided (sometimes called a leaf). In a Work Breakdown Structure such elements (activity or 

deliverable), also known as work packages, are the items that are estimated in terms of resource 

requirements, budget and duration; linked by dependencies; and scheduled. At the juncture of the 

WBS element and organization unit, control accounts and work packages are established and 

performance is planned, measured, recorded and controlled.   A WBS can be expressed down to 

any level of interest. Three levels are the minimum recommended, with additional levels for and 

only for items of high cost or high risk, and two levels of detail at cases such as systems 

engineering or program management, with the standard showing examples of WBS with varying 

depth such as software development at points going to 5 levels or fire-control system to 7 levels. 

 

Example 

The figure below (next page) shows a work breakdown structure construction technique that 

demonstrates the 100% rule and the "progressive elaboration" technique. At WBS Level 1 it shows 

100 units of work as the total scope of a project to design and build a custom bicycle. At WBS 

Level 2, the 100 units are divided into seven elements. The number of units allocated to each 

element of work can be based on effort or cost; it is not an estimate of task duration. 

 

The largest three elements of WBS Level 2 are further subdivided at Level 3. The largest two 

elements at Level 3 each represent only 17% of the total scope of the project. These larger 

elements could be further subdivided using the progressive elaboration technique described 

above. 
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The WBS construction technique employing the 100% rule during WBS construction. 

 

WBS design can be supported by software (e.g. a spreadsheet) to allow automatic rolling up of 

point values. Estimates of effort or cost can be developed through discussions among project team 

members. This collaborative technique builds greater insight into scope definitions, underlying 

assumptions, and consensus regarding the level of granularity required to manage the projects. 

 

Misconceptions 

 A WBS is not an exhaustive list of work. It is instead a comprehensive classification of 

project scope. 

 A WBS is none of a project plan, a schedule or a chronological listing.  It specifies what will 

be done, not how or when. 

 A WBS is not an organizational hierarchy, although it may be used when assigning 

responsibilities. See also: responsibility assignment (RACI) matrix (also called a Staffing 

Matrix). 

 A WBS is not a Result Breakdown Structure. Projects are not about work (or effort) but 

about results in terms of deliverables or capabilities that the project must provide. Planning 

a project is a reverse process. First, you identify the deliverables, and then the work 

required to create them. Therefore, creating a Deliverable Breakdown Structure, or a 

Capability Breakdowns Structure is the first step. Once the deliverables are identified the 

next step is to define the activities that are necessary to create these deliverables. A cross-

check is required to ensure that for each deliverable, there is at least one activity that 

creates it. Starting project planning with a Work Breakdown Structure is a common 

misconception causing time and budget overruns. 
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From:  https://superuser.com/questions/601713/how-to-allow-enable-the-weekends-as-working-period-in-gantt-project  

 

GanttProject: Enable weekends as work time 
 

By default, GanttProject allows for a five-day working week, with no activity on Saturdays or 

Sundays.  There are projects (such as weddings, 24/7 and/or urgent projects) where work must 

span across weekends.  GanttProject can be configured to provide for such requirements. 

 

To enable weekends as work time: 

1. Go to Project > Properties > Calendar  

2. Choose On weekends > all tasks run as on other days 

3. Click Ok   

 

GanttProject only provides for durations measured in days. 
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Source:  direct inspection  

 

GanttProject: Search 
 

Searching in GanttProject is really only useful in 

large, multipage projects where it is slow to scan 

through all the data items.   

 

The Search box is always present in the top right 

corner above the timeline.  

 

Search only examines the data in the Name columns under the Gantt or Resource chart tabs.  

 

To make a search 

1. Click in the Search box and delete its 

prompt 

a. Edit > Search also places the cursor in 

the search box 

2. Type a fragment of the target into the box 

and press [Enter] 

3. A list appears of all occurrences of the 

target fragment 

4. Click on an item in the list and it will be 

highlighted in the relevant Name column 

 

To display all available data items 

1. Click in the Search box 

2. Delete all content in the box 

3. Press [Enter] 

4. A full list of all data items appears   

 

  



Source:  various fragments  

 

GanttProject: Change the logo 
 

GanttProject has its logo displayed above the 

data tables in both Gantt view and Resources 

chart view.  It is possible to use a logo supplied 

by the user instead.   

 

First, use graphics software such as MS Paint to create your replacement logo.  It should be:  

 a single file: 

 50 x 1200 pixels (height x width) in size 

o Make the leftmost 300 pixels the main logo and the rest some repetitive pattern 

 Saved in .PNG (or else .JPG) format 

 Preferably without spaces in the name 

 

Save the file in an accessible place, perhaps in "C:\Program Files (x86)\GanttProject-2.8\” with the 

other GanttProject files. 

 

1. In GanttProject, go to Edit > Settings > Application UI > Logo file 

2. Click the Browse… button to navigate to your logo file 

 

 

 

 

 

 

3. Click Ok 

4. Restart GanttProject and look to see the replacement logo. 

5. To revert to the GanttProject logo, simply delete your Logo file selection. 

 

  



From:  https://software.grok.lsu.edu/article.aspx?articleid=7465  

 

GanttProject: Adding a Resource  
 

With GanttProject, the user can not only create new tasks for their chart, but they can also add 

personnel (resources) to be assigned to that task. The following steps show how to add a resource 

in GanttProject.  

 

Adding a Resource: 

 

1. In the menubar, click Resources 

and then select New Resource 

from the drop-down menu.   

 

 

 

 

2.  A Resources dialog box appears. Type in 

the new resource's information and click Ok 

at the bottom of the window to close it. 

 

 

 

 

 

 

 

3. Above the GanttProject logo, click on 

the Resources Chart tab to view the 

newly created resource. 

 

 

 

 

 

Edit a resource 

To add to or change details of a resource: 

1. On the Resources chart tab, highlight (click on) the resource to be edited. 

2. On the menubar, choose Resources > Resource properties. 

 

Assign resources 

To assign resources to tasks, go to Task Properties in the Gantt view. 

Do not assign resources to summary tasks.  This may conflict with assignments in subtasks.  
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From:  http://ganttproject.blogspot.com.au/2017/05/ganttproject-285-task-sorting.html  

 

GanttProject: Sorting tasks  
 

GanttProject 2.8.5 and later come with a useful feature: task ordering by begin/end dates.  

 

 
Sample project with tasks sorted by begin date 

 

Task sorting 

Sorting works in the expected way: click the column header to sort in ascending order, click again 

to toggle to descending order.  The sort-order is indicated by an arrow in the column header, 

showing upwards when order is ascending or downwards when it is descending. 

 

The sort order is compartmented. Sibling tasks are sorted, while tasks from different branches of 

the task tree (i.e. sitting under different summary tasks) are not necessarily sorted.  For instance, 

on the screenshot above, milestone GanttProject 2.8.5 goes below the child tasks of Architectural 

design, although it starts earlier.  

 

Sorting is not maintained continuously. Any actions on the tasks such as insertion of a new task, 

reordering, indenting and outdenting may break the sort order. The user must then click in the 

column header again to restore the ordering. 
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From:  https://software.grok.lsu.edu/article.aspx?articleid=7472  

 

GanttProject: Export a project as PDF  
 

GanttProject allows the user to export a project in many different formats, allowing projects to be 

easily shared.  The following steps will show the user how to export the project as a .PDF file.   

 

Exporting a Project to a .PDF file: 

 

1. Select Project from the menubar at the top of 

the window, and then select Export from the 

dropdown menu. 

 

2. The Export wizard dialog box opens (below). 

Select the PDF report option at the bottom and 

choose the desired visual theme from the 

dropdown menu (there is only one).  

 

3. Click Next. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Next, choose where the file will be stored with 

the Browse button at the top right; edit the name 

of the file if needed. You can also edit the date 

range to be exported, the paper format, and 

whether to show notes.  

 

5. Click Ok at the bottom right when finished. 
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From:  http://forum.ganttproject.biz/view/20131002213302_6wfmmu1kbpgeiq6rba172ky4l  

And:  https://github.com/bardsoftware/ganttproject/issues/919  

 

GanttProject: Baseline use 
 

When you create a baseline, you create a snapshot of all the task dates. Afterwards, when you 

change a task date, the baseline dates and current dates can be shown next to each other on the 

timeline.   

 If some current task completes later than its baseline version, the baseline bar is 

shown in red  

 If the current task completes earlier than its baseline version, the baseline bar is 

shown in green.  

 If there has been no change, no baseline bar is displayed 

 

You can keep creating additional baselines, each with a different name, most likely after any major 

change to your project, and later see how each compares to your current state.  

 

 
 

Create a baseline 

1. On the Gantt view, above the Timeline, click the Baselines… option  

2. In the Edit Baselines dialog box that appears, click the Add button 

3. In the text edit box that appears, type a name for the baseline 

4. Change the display colours if desired, and then click Ok. 

 

Compare a baseline 

 Click the Baselines… option 

 In the Edit Baselines dialog, select the desired baseline name  

 Click Ok to close the dialog  

 The red/green baseline bars appear immediately after choosing the baseline name. 

 If there have been no changes, no baseline bars appear. 

 To deselect a baseline name, in the dialog box, click on <Type new baseline name here> 

 
next page … 
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Gantt view – saved baseline 

 
 

 

Gantt view with baseline after some changes 

 
 

By inspection, task review rough draft has a longer duration, task RD corrections has a shorter 

duration and the whole project is shorter. Task rough draft was unaffected. 

 

 

  



From:  compiled manually from a variety of fragments 

 

GanttProject: Data table columns  
 

The GanttProject user interface has two tab views, called Gantt and Resources chart.  Each view 

has, on the left, a table with data displayed in columns.   

 

The columns of the tables can be managed extensively: 

 Sort by data in the columns 

 Change the left to right order of columns  

 Show/hide standard columns or Add/Delete custom columns 

 

Sort on a column: 

It is only possible to sort on the Begin date and End date columns on the Gantt tab 

To sort, click on the date header.  Click again to reverse 

See task sorting 

 

Column order 

To change the column order, drag column headers to the left or right as desired 

 

Column types 

There are two types of columns, standard and custom 

 

Standard columns 

Sets of standard columns are provided for the Gantt tab, and for the Resources Chart tab. 

Some standard columns are displayed by default.  Additional standard columns must be selected 

by the user.  All standard columns may be hidden if desired. 

 

Properties of standard columns are fixed; they cannot be changed.  This is because most standard 

columns have computed properties. 
 

The standard columns are: 

Gantt Resources Chart Default column 

Name 
Begin date 
End date 
 
Alerts  
Completion 
Coordinator 
Cost 
Duration 
ID 
Predecessors 
Priority 
Resources 
Type 

name 
default role 
phone 
 
Assignment role 
Standard rate 
Email 

Yes 
Yes 
Yes 

 
No 
No 
No 
No 
No 
No 
No 
No 
No 
No 

 

Begin managing columns 

 First choose the tab to work on, Gantt or Resources chart 

 Right-click any column heading and select Manage columns… 

 A Custom Fields Manager dialog box appears. 



Show a standard column 

 In Custom Fields Manager, click on the desired column heading to highlight it (blue) 

 Click the Show selected button 

 The desired heading appears at the right of the existing column headings. 

 To remove a column, in Custom Fields Manager, highlight its heading (in blue) and click 

the Hide selected button. 

 

Gantt Standard Column Functions  

 Cost of a task is, by default, the calculated cost of the resources assigned to the task.  

Tasks are summed to derive the cost of each summary task.   

 Duration shows the duration of each task and the critical path total for any summary task. 

 Alerts show tasks that are behind schedule or overdue. They consult percentage complete 

for each task.  If you show column "Alerts" in the task table, it will show yellow icons for 

tasks which are partially complete and red for overdue. 

 Completion shows the percentage completed for tasks and summary tasks.  It consults 

percentage complete for each task.  Percentages must previously be entered manually. 

 Coordinator can be used to identify the coordinator (a resource) for the summary task. 

 ID shows the Identity number of each task.   

 Predecessor shows the preceding task ID(s) for each task. 

 Outline number displays a decimal numbering system to identify the group and task order 

for each task.  Tasks are defined by indenting.  Two indent steps are possible, allowing 

three levels of grouping.  This means that three Outline number forms may occur, e.g. 2 

and 2.3 and 2.34 could appear. 

 Priority shows the priority ascribed to the task in Task Properties 

 Resources shows the resource personnel assigned to the task.  

 Type shows icons that indicate whether a task is a summary task, a task or a milestone. 

 

Resource chart standard functions 

 Assignment role allows allocation of a specialized role for a particular task 

 Standard rate is the pay rate of a resource.  A currency unit is not specified. 

 

Custom columns 

Custom columns must be created and defined by the user.  Custom columns cannot be given 

additional enhanced actions. 

Custom columns may be inspected in Task Properties. 

 

Add/delete a custom column 

 Scroll to the end of the list of standard column names 

 Click on the Add button 

 In the text box that appears below the list, type the desired name of the additional column 

 Press Enter 

 On the right, set the Type and Default values.  Any set default value will automatically 

appear in each cell of the column. 

 To remove a custom column, in Custom Fields Manager, highlight its heading name (in 

blue) and click on the Delete button. 

 

  



From:  https://software.grok.lsu.edu/article.aspx?articleid=7493  

 

GanttProject: Add Roles  
 

Resources are the personnel who carry out activities. 

Roles are the names of the task types (jobs) that personnel can carry out. 

For example, (resource) Alan Smith is a (role) carpenter. 

The default roles in a new project are project manager and undefined.  It is usual to add specific 

roles to a project for reasons of clarity and detail specification. 

 

To add extra role names: 

1. In the menubar, choose  Project > Properties  

2. In the Settings dialog box that appears, choose Resource Roles 

3. For each desired role name: 

a. In the text box called <Type new role name here>, type the desired name 

b. Click the Add button 

4. To remove a role, in the list of roles, highlight the role name and click on the Delete button 

5. Click Ok 

 

 

  

https://software.grok.lsu.edu/article.aspx?articleid=7493


From:  https://software.grok.lsu.edu/article.aspx?articleid=7493  

 

GanttProject: Record time-off for a Resource  
 

GanttProject allows the user to record time off from work, such as vacations, leave, etc., for 

individual resources. 

 

NOTE: Weekends are by default treated as days off. To change this, read here. 

 

Recording Time-off for Resources: 

1. Select the Resources chart tab (above the GanttProject logo), and right-click on the resource 

for which time off needs to be added.  From the drop-down menu that appears, click on 

Resource Properties. 

 

 
 

4. The Resources dialog box appears. Select the Days off tab at the top of the window. Click the 

button to the right of the start date entry field. A calendar will appear to allow the user to select 

a start date. Repeat this for the end date as well. When the dates have been selected, click 

the Add button at the left under the End date field. 

 

 
4. The selected time period will be shown below the Add and Delete buttons.  

https://software.grok.lsu.edu/article.aspx?articleid=7493


5. The user can select an additional time period to add if it is desired.  

6. When the user is finished adding time off, click Ok at the bottom of the window. 

 

 
 

7. The time periods that have been selected will now appear in the Resource chart timeline. 

 

 
 

  



Based in part on:  Project Scheduling with GanttProject 

 

GanttProject: Using GanttProject 
 

The whole experience 

There is a lot more to project management than using software to monitor the project plan, but it 

has a place.  First, here is an outline of how to use GanttProject software to good effect: 

1. On paper, assemble a WBS (work breakdown structure).  This is a list of all the work tasks 

that must be carried out to bring the project to completion.  Some people use mind map 

software to help with this, especially when consulting clients and team members. 

2. Determine the necessary roles (job descriptions of personnel) 

3. Select resources (personnel) for the project and identify their roles 

4. Plan how resources will be assigned to tasks. 

5. Here see the plan, on paper, of the really simple project devised for this tutorial.  

a. It is a plan for a software design project 

b. There is one summary task 

c. There are six action (child) tasks 

d. There are four roles, including the default Project manager role 

e. There are four resources (personnel) 

6. When you come to create the software design project in GanttProject, you will follow these 

steps:  

a. Start a new project 

b. Enter roles (types of personnel) 

c. Prepare the task list display format 

d. Enter tasks 

e. Add dependencies (links) 

f. Add resources (personnel) 

g. Allocate resources to tasks 

h. Adjust initial resource allocations 

i. Modify the plan as the project progresses, guided by the Gantt display 

Preparation 

1. Create the WBS.  This task has been completed for you.  See it on p.38 here.  

2. The details of the plan were prepared on paper like this: 

a. List tasks  

i. First identify summary task (the big picture task) 

ii. Identify and group action tasks, in order, under the summary task 

iii. Insert a milestone (checkpoint) 

iv. Add duration of each action task (use only days in GanttProject) 

b. list necessary roles  

c. list and allocate resources   

 

Now Launch GanttProject  

1. In GanttProject, start a new project: 

1. Project > new > Name and description > enter details (look on WBS page) > Ok 

2. Enter roles 

a. Project > properties > resource roles >  

i. type role name > click Add > repeat as needed (look on WBS page) 

1. do not add project manager; it is a default role and already there 

ii. click Ok    

http://myegr386wguide.weebly.com/uploads/2/6/5/5/26550452/ganttproject-info1.pdf


3. Add the Outline number column to task list and reorder the columns: 

a. On the Gantt tab, right-click any column heading and select Manage columns… 

b. In the displayed list, find and click to highlight Outline number 

c. Click Show selected (at the top) then click Ok 

d. In the column headings, drag the Outline heading from far right to far left 

4. Enter tasks  

a. For all WBS tasks (including the summary task) in order: 

i. Right-click under headers > new task > type task name > press [Enter] 

b. Indent all child tasks under the summary task:  

i. Highlight the group of child tasks: 

1. click the top one, hold shift, click the bottom one 

ii. right-click the highlighted group of tasks > indent 

c. Add task details (look on WBS page) (not for the summary task):  

i. Click then right click each child task > Task properties > add duration > Ok 

1. Summary task duration will be automatically computed 

ii. For the milestone, only tick (check) the Milestone box (near the top)  

5. Add task dependencies (see Dependency management for details of link types) 

a. Do not link a summary task to its members (the indents identify the child tasks) 

b. Highlight the group of child tasks (see above): 

c. click Create dependencies … (above the logo),   

i. FS type link arrows appear in the Gantt chart 

d. edit dependencies on the dependent tasks where needed: 

i. interview analysis and GUI mock-up design should start together (SS) so: 

1. Right-click  mock-up design > Task properties > Predecessors tab > 

click interview analysis row > Type > SS > Ok 

ii. User validation of mock-up can only start if both interview analysis and GUI 

mock-up design are finished.  GUI mock-up is already linked to User 

validation … so now add interview analysis: 

1. Right-click User validation …> Task properties > Predecessors tab > 

Add button > choose interview analysis from Task name drop-down > 

see Type is FS > Ok 

e. Notice that dates have been computed, based on your input. 

6. Add resources 

a. For each resource (look on WBS page):  

i. Go to Resources chart (click the tab)  

ii. Right-click under Name header > New resource  

iii. Complete Resources dialog box (Name, role and payment rate) and Ok 

7. Assign resources to tasks (look on WBS page) 

a. For each task: 

i. On the Gantt view, right-click the task > Task properties 

ii. In the dialog box, click the Resources tab 

iii. For each resource  

1. Click Add > supply details (pull-down > name | unit is the %)  

iv. Click Ok 

 

8. Your project is complete.  Now to check and adjust. 

 

Next page … 

  



9. Check Resource allocation 

a. On the Resources chart view, look for red task bars on the timeline 

i. Red bars indicate over-committed time. 

ii. Green bars indicate committed time 

iii. Grey bars indicate uncommitted time 

 

 
Resource allocation problem 

 

 
Gantt chart before resource correction 

 

10. Resolve resource allocation problems 

a. Reallocate tasks if other resources are available 

b. Display critical path and adjust non-critical durations (see display critical path): 

i. On the Gantt view, select Show critical path (above timeline) 

ii. By inspection, change task durations ** 

c. Inspect the Resources view to ensure red bars have been eliminated 

 

** To fix the Bob Smith problem:  

1. Increase the duration of Interview analysis from 2 to 4 (days):  

a. in Gantt > interview analysis > task properties > duration 

2. Reduce his allocation to interview analysis from 100% to 50%: 

a. in Gantt > interview analysis > task properties > Resources tab > Smith, Bob 

 

What next? 

Explore the project file called HouseBuildingSample.gan that came with GanttProject.  



Paper based lists used in the Using GanttProject tutorial 
 
 
Sample WBS task list – Software design project 
 
WBS #  Name  Duration (days) 
1.0  Requirement Analysis  – (WBS# of 1.0 means a summary task) 
1.1  User interviews  2 
1.2  Interview analysis  2 
1.3  GUI mock up design  4 
1.4  User validation of mock-up 2 
1.5  Writing User Requirements  2 
1.6  User Requirements Review Meeting  MS MS = milestone; duration is automatically 0 

   (but is displayed as 1 in Task Properties…) 

 
 

 

Sample roles and resources list 

 

Role Resource Payment rate 

Project manager Schmidt, Alice 250 * 

Analyst Smith, Bob 200 

Programmer Ali, Pal 150 

Tech writer Babbitt, Den 150 

* GanttProject does not specify monetary units 

 

 

Sample Resource list 

 

Outline # Task Schmidt Smith Babbitt Ali 

1.1 User interviews 10% * 100% 0% 0% 

1.2 Interview analysis 10% 100% 0% 0% 

1.3 GUI mock up design 10% 50% 0% 100% 

1.4 User validation of mock-up  20% 50% 50% 0% 

1.5 Writing User Requirements 20% 0% 100% 50% 

* Percentage of work time allocated to the task for its duration 

 

  



Source:  compiled from direct inspection 

 

GanttProject: The user interface 
 

The GanttProject user interface has two views, called Gantt and 

Resources chart.  Only one view can be seen at a time.  The 

desired view is selected by clicking a tab (either Gantt or 

Resources chart) found near the top left of the window.  

 

 The Gantt view (default) has a pane on the left that shows a table of task details and a 

pane on the right with a matching Gantt chart timeline.   

 The Resources chart view has a pane on the left that shows a table of personnel 

(resources) and a pane on the right with a matching timeline of task loads. 

 

The Gantt view 

 
 

The Resources chart view 

 
 

While viewing either the Gantt view or the Resources chart view, it is 

possible to extend either the data table pane or the timeline pane across 

the full width, just by clicking on the small black arrowheads at the top of 

the vertical separating bar. Click the reverse arrow to go back to the 

double-pane display. 

 

On both views, the timeline pane can be moved to the left or to the right 

(and moved up or down if the data table is long) by using click and drag. 

  



Further details (see screenshot below): 

 On either view, on the chart pane, vertical blue lines show the boundary dates of the whole 

project.   

 On both views, a vertical red line on the timeline pane indicates the position of today.   

 Clicking on / Past / Future / (found above the timeline) scrolls the chart display to the left / 

right.  

 Clicking Today (also found above the timeline) repositions the chart display with today at 

the left-hand margin. 

 Zoom in to manage details of short duration projects.  The timeline is graduated in 

individual days. 

 Zoom out to view the full range of long duration projects.  The timeline graduation changes 

to weeks and then to months (never to years), but the duration of a task continues to be 

measured in days.  Multi-year projects are possible. 

 

 
The Gantt chart pane of the Gantt view 

 

 

  



Source:  GanttProject forum 

 

GanttProject: Add comments to Gantt chart taskbars 
 

It is possible to add details to Gantt chart bars, so that this: 

 

 

 

will look like this: 

 
 

To do this, choose Edit >Settings >Gantt chart >Task details and select pull-down options (below): 

 

 
 

Some locations can be left blank or different options chosen. 

When you have made your selections, press Ok. 

 

To remove the details on the bars, in the pull-down options for each row of Task Details, scroll up 

and choose the blank option at the top. 

 

  



Source:  GanttProject forum 

 

GanttProject: Add and show notes for a task 
 

It is possible to add notes about any task, like this: 

1. On the Gantt view, in the task table, right-click on the desired task and click Task 

Properties… 

2. In the Properties dialog box that appears, in the Edit Notes field, type any desired notes. 

 

 
 

3. Click Ok. 

 

When any notes for a task have been entered, an icon appears 

in that row of the Gantt chart, fixed at the right-hand end.  

Hover the mouse pointer over the icon to display the notes. 

  



Source:  GanttProject forum 

 

GanttProject: Using the Priority setting 
 

Each task has a Priority setting, Normal by default. 

Available settings are: Very Low / Low / Normal / High / Very High 

To view task priorities, a Priority column can be added to the task list on the Gantt view.  In the 

column, a small coloured circle appears for each task.  The circle colour is green for Very Low / 

Low, blue for Normal and red for High / Very High priorities 

Priority use is entirely manual.  The user imposes the setting and monitors them by inspection. 

 

To change the Priority status of a task: 

1. On the Gantt view, right-click the task and choose Task Properties… 

2. A Properties dialog box appears; choose the desired setting from the Priority pull-down list 

3. Click Ok 

 

To add a Priority column to the task list 

1. On the Gantt view, right-click the task and choose Manage Columns … 

2. In the Custom Field Manager dialog that appears, find and highlight the Priority option 

3. Click the Show selected button 

4. Click Ok 

5. If necessary, adjust the column widths in the task table. 

 

 

  



GanttProject for Beginners 
 

Introduction 

Project management involves the overview of a team whose members work cooperatively to 

produce an end product or service that benefits an organisation.  The project has an end goal that 

is achieved by completing a sequence of interrelated tasks.  

 

GanttProject is a software package that allows effective, on-going management of project data.  

The application is particularly suited to the so-called waterfall model of project management, in 

which tasks must be executed in an inter-related sequence, leading to a final end goal state. 

 

This document provides the unfamiliar user with an emerging introduction to GanttProject.  It will 

be somewhat easier if the user has a beginning understanding of project management concepts. 

 

Terminology 

A few terms will appear repeatedly as we progress.  It will help if the reader has an understanding 

of each of these terms.  They are: 

 

Project – a project is a sequence of inter-related tasks that lead to a definite end goal. 

Task – A task (or subtask for clarity) is an activity with a definite beginning and end that 

contributes in its turn to delivering the end goal. 

Summary task – A summary task achieves an overarching objective by executing a sequence of 

subtasks. 

Resource – A resource is a person, commonly identified by name, who causes a task to be 

executed.   

Role – A role is assigned to a resource to describe its useful ability, such as clerk or engineer. 

Link (or dependency) – Tasks must commonly be executed in order, with one task waiting to start 

until another has been completed.  This is shown on a Gantt chart by arrows (links) from task to 

task in the order of execution. 

Milestone – a formal checkpoint in a task sequence, such as at the end of a summary task. 

Default – a default setting is the initial setting imposed by the software. 

Click – the standard mouse left-click.  

Title bar, menubar, toolbar – the top three rows of the GanttProject program window 

  



Source:  GanttProject forum 

 

GanttProject: Cost management 
 

GanttProject provides for calculating the cost of resources (personnel) assigned to each task, and 

hence the cost of the whole project.  The cost of the project, or of any summary task, is the sum of 

the costs of individual tasks.   

 

In calculating the cost of an individual task, the contributing factors are: 

 The duration (in days) of the task, which gives the time for which resources are deployed 

 The daily cost of each resource, being the standard rate from the Resource Payment Rate 

in Resource Properties (this has no stated currency)  

 The utilization (as a percentage) of a resource’s time devoted to the task; this is the unit 

value found in Gantt tab > task > Task Properties... > Resources tab > unit (see below) 

 The number of resources assigned to the task 

 

 
 

Costs are calculated automatically by default; the cost is calculated for each resource by: 

Cost = duration X standard rate X unit / 100 

The whole cost of a task is the sum of all individual resource costs (even when there is just one). 

 

An explicit cost of a task may be typed in at Gantt > Task properties > Resources tab (see above) 

The cost of a summary task is the sum of individual task costs, but can also be set manually. 

There are usually multiple summary tasks in a project.  To get a cost for a whole project, just 

create a single top-level whole project task and indent all tasks one more step under that new one. 

 

Cost and standard rate can be shown as columns in both task and resource tables (for displaying 

columns, see GanttProject: Data table columns). 

 

  



Source:  GanttProject forum 

 

GanttProject: Manage calendar details 
 

By default, GanttProject assumes that work on a project takes place, Monday to Friday without 

weekend work, all year.  In reality, work may run for the whole seven-day week (rush job), or 

Wednesday to Sunday (a restaurant) for example.  Further, most communities enjoy public 

holidays and individual people take leave for a variety of reasons.  GanttProject can allow for all of 

this.  However, GanttProject only provides for durations measured in whole days. 

 

To prepare to manage calendar matters 

 Go to Project > Properties > Calendar  

o The settings apply to the whole project 

 

To enable working across weekends 

 Choose On weekends > all tasks run as on other days.   

o Tasks then run without weekend disruption, and minor changes are made to the 

layout of days on the Gantt chart pane 

 See also GanttProject: Enable weekends as work time 

To relocate the weekend break to other days of the week 

 In the row Choose weekend, check the two days which form the break. Uncheck the rest. 

o These settings can be varied as you work through the project. 

 

To allow for public holidays 

 From the row Holiday calendar, choose your relevant list from the pull-down menu. 

You can inspect the selected list just below on the One-off and Recurring tabs. 

 

To allow for an individual resource’s leave of absence 

Leave for an individual resource does not apply to the whole project and is handled differently. 

See GanttProject: Record Time-Off for Resources 

 

Allocation of start dates 

When a new task is first added (without details), the new taskbar will appear, starting at the earliest 

date currently displayed in the Gantt chart pane.  The Begin date and End date will be 

automatically derived and displayed when links are inserted. 

 

Move project start date 

In Project > Properties > Calendar there is an option called Move project start date (near the 

bottom of the dialog box).  Use this setting to change the whole project to a different starting date. 

 

Import holiday calendars in iCalendar format 

The placement of public holidays in the calendar is quite arbitrary and changes from year to year.  

Assembling a world-wide list is an arduous task.  Many individual calendars are now available 

online in iCalendar format published on Mozilla Holiday Calendars or iCalShare  web sites.  These 

calendars can be imported into GanttProject.  The procedure is: 

1. Find the required calendar online 

2. Download the iCalendar as a .ICS file 

3. In GanttProject, use Project > Import to import the .ICS file  

  

http://en.wikipedia.org/wiki/ICalendar
https://www.mozilla.org/en-US/projects/calendar/holidays/
http://icalshare.com/


Use a neutral day 

Occasionally it may be necessary to designate a day as neutral.  This day will then not be 

considered in any GanttProject analysis.  To set a day as neutral, choose Project > Properties > 

Calendar > One-off > Add (enter date) > Type (choose neutral).  You can also choose a reminder 

colour that appears in the timeline charts. 

 

 

  



Source:  GanttProject forum 

 

GanttProject: Link (dependency) management 
 

It is usual for project tasks to happen in sequence.  For example, a particular task must wait until 

its predecessor runs to completion.  Paint the wall (the successor) must wait until build the wall (the 

predecessor) is complete.  In a Gantt chart, a relationship like this (called a dependency) is 

commonly represented by an arrow (called a link) from the finish of one task to the start of the next.  

 

There are multiple ways of inserting links into a Gantt chart in GanttProject. 

 

To begin, you must have already set up a Gantt data table, with task names and durations.  This 

will cause the representative bars to appear on the Gantt chart in the right pane.  Linking the tasks 

automatically inserts Begin dates and End dates. 

 

Insert a single link between two tasks 

In the Gantt chart on the right: 

1. Left-click and hold anywhere on the predecessor task. 

2. Drag to anywhere on the successor task 

3. Release the left mouse button. 

4. A joining arrow will appear between the two. 

 

Clear all links within a set of tasks 

1. In the data table, highlight the whole set of tasks, like this: 

a. Click and release on the top task. It will remain highlighted. 

b. Hold down a Shift key and click on the bottom 

task.  All tasks between become highlighted. 

2. Click the Remove all dependencies … toolbar icon  

3. All links in the selected region disappear. 

 

Insert a string of links within a set of tasks 

1. Highlight the whole set of tasks (see above) 

2. Click the Create dependencies between selected tasks.  

3. A series of links will appear, running down the tasks.  

 

These links, the most common type, pass from the finish of the predecessor task to the start of the 

successor task.  They are called finish-to-start or FS links.  Altogether, four types of links are 

possible.  See them here: 

 

Possible Task Dependency Relationships 

Finish-to-Start (FS) 

 
Paint Fence 

 

Start-to-Start (SS) 

 
 

Finish-to-Finish (FF) 

 
 

Start-to-Finish (SF) 

 starts (rare) 
 

  



Insert a link of a less common type 

Links created by dragging in the Gantt chart, or by using the icons, are all FS links. 

Links of the less common types must be created one at time.  Here is how: 

 

1. First create an FS link between the desired tasks; use dragging or icon.  

2. Right-click the successor task and choose Task Properties...  

3. In the Properties dialog box that opens, choose the Predecessor tab 

4. Click the cell under the Type heading. A pull-down menu appears. 

5. Choose Start-Start 

6. See something like this: 

 

 
 

7. Click Ok 

8. In the Gantt chart pane, see two bars with a link like this: 

 

The link indicates that the lower task cannot start until the upper task starts. 

 

Manage a delay (also called lag) between tasks 

Sometimes a successor task cannot begin immediately after a predecessor.  For example, after 

the task paint the car, there needs to be a pause while the paint dries, before we execute the task 

drive the car away.  To provide for this, we use a delay setting, like this: 

 

1. First create an FS link between the desired tasks; use dragging or icon.  

2. Right-click the successor task and choose Task Properties...  

3. In the Properties dialog box that opens, choose the Predecessor tab 

4. In the delay column change the zero value to the desired delay length (in days) 

5. Double-click the cell, change the value, press [Enter].  See something like this: 

 

 
 

6. Click Ok 



7. Inspect the new link in the Gantt chart.  The before and after links look something like this: 
 

Before:  After:  

 

 

 

You can also use negative delay (e.g. -1), after which it looks like this: 

This allows a task to begin at a fixed time before it precursor finishes.   

 

Manage link hardness 

Standard practice when creating a Gantt chart is to define the duration of each task and the Begin 

date of only the first task.  When the links are set up, GanttProject computes all the other dates.  

 

The default FS link requires that a successor task must start as soon as the predecessor 

completes.  Therefore, later changing a duration can result in the recalculation of multiple task 

dates.  In a complex Gantt chart, this wholesale change of dates can disrupt the whole plan. 

 

To avoid this worry, a link property called link hardness has been incorporated.  It has two possible 

values, strong and rubber.  The link hardness value is chosen by going to the successor task and 

choosing Task Properties… > Predecessor.  It looks like this (familiar?): 

 

 
 

To choose the link hardness setting, go to the link hardness column.  There, click on the current 

value to open a pull-down list, choose the desired option and click Ok. 

 

The effect of the link hardness setting is visible in the Gantt chart.  It all looks like this: 

 
Initial appearance with default strong link hardness: 

 
Appearance with rubber link hardness (note the line gap behind the arrowhead): 

 
Appearance after reducing the duration of the predecessor task (note the dotted link): 

 
 

It is generally accepted that rubber is the better default Link hardness setting.  This can be set at 

Edit > Settings > Gantt chart > Link hardness 

  



Source:  GanttProject forum 

 

GanttProject: Display the critical path 
 

In a Gantt chart, the critical path is the sequence of linked tasks that has the longest total duration.  

The path has no slack and determines the End Date of the project. 

 

In GanttProject, display the critical path of a project like this: 

1. Choose the Gantt view 

2. Click the option Show critical path above the timeline.   

3. See critical path taskbars emphasized (cross-hatch) 

4. To dismiss the critical path, click the option Hide critical path above the timeline 

 

A Gantt chat before displaying the critical path 

 
 

A Gantt chat displaying the critical path 

 
  



Source:  Manually compiled 

 

GanttProject: View a PERT chart 
 

The two working views of GanttProject are selected from the tabs Gantt and Resources chart.  A 

third view is available which displays a PERT chart of the project.  This chart is effectively read-

only.  Its elements can be moved on the view, but dependencies cannot be changed and any 

changes of layout are discarded whenever the project is closed.   

 

The PERT chart displays dependencies more clearly than does a Gantt chart.   It also displays the 

critical path by the colour of its tasks. 

 

To display the PERT chart, from the menubar, choose View > PERT (the only option).  This adds a 

view tab beside Gantt and Resources chart. 

 

A project in Gantt view 

 
 

The same project in PERT view 

 
  



From:  http://www.gantt.com/creating-gantt-charts.htm  

 

Creating Gantt Charts  
 

GanttProject does not offer all the options described here 

 

 Linking tasks 

 Adding constraints 

 Including resources 

 Enhancing Gantt charts 

 Reviewing the project 

 

Gantt charts are widely used in business to describe and monitor all kinds of projects, consistent 

with the rules of project management. In today's world they are usually created by computer 

applications, such as Microsoft® Project, Primavera Project Planner® and MindView. Here, we 

refer to such applications as Gantt applications. Different Gantt applications have different features 

and capabilities: in the discussion below we describe some of the more common characteristics. 

 

The first thing you will need before setting up a Gantt chart is a detailed project plan. A project plan 

is a series of interdependent tasks that need to be performed in a particular order. When moving 

into a new office for instance, you cannot start rearranging the office space before the lease 

agreement has been signed. 

 

Project plans have a specific start date, corresponding to the start of the first task (for instance 

defining the requirements for the new office), and a specific end date, corresponding to the end of 

the last task (for instance moving in). 

 

One way to create a project plan is to use a work breakdown structure, a technique for splitting 

tasks into sub-tasks and creating a task hierarchy. Gantt applications will generally allow you to 

reflect the project hierarchy in the Gantt's task list at the left of the chart. 

 

 
Gantt chart task hierarchy  

 

Mind mapping software, which encourages creative thinking, will help you to develop a work 

breakdown structure and ensure that nothing is omitted from the overall project plan. If the mind 

mapping software incorporates Gantt charting (e.g. MindView), it will allow you to enter data as you 

develop the plan, saving time later. Make sure your plan is as complete as possible and its 

assumptions are realistic. 

http://www.gantt.com/creating-gantt-charts.htm
https://www.matchware.com/gantt-chart-software
https://www.matchware.com/wbs-software
http://www.mindmapping.com/
https://www.matchware.com/mind-mapping-software
https://www.matchware.com/mind-mapping-software


Once the project plan is complete, enter the data into the Gantt application that will create the 

chart: 

 

How to Create a Gantt Chart 

 Define the project settings, such as its start date, end date and scheduling mode. The most 

common scheduling mode is forwards from the project start date. In this mode the default is 

for tasks to start as soon as possible, which means that the whole project finishes at the 

earliest possible date. 

 Define the project calendar. This sets the number of working days in the week, the number 

of working hours in the day, and so on.  GanttProject only works in days. 

 Enter or edit task names and durations. 

 Set up a global resources list and assign resources to tasks. Although you can often define 

the resources as you need them, it is usually quicker to start by setting up a global 

resources list from which you can then select resources to assign to the various project 

tasks. See Including resources in a Gantt chart. 

 Create links to specify the dependencies between the project tasks. See Linking tasks in a 

Gantt chart. 

 Set constraints on the tasks as necessary. See Adding constraints to a Gantt chart. 

 Make final adjustments to the project plan. See Enhancing a Gantt chart. 

 Once the project has actually started, inspect it at regular intervals to detect potential 

problems or scheduling conflicts and make any corrections required. See Reviewing a 

project using a Gantt chart. 
 

Note: If you used mind mapping software that incorporates Gantt chart creation during the planning stage, much of this 

data will already be in place. 

 

With all the data entered, the Gantt application displays the chart. Any change in the timing of a 

task affects all the tasks that depend on it. If a task runs ahead of schedule, the Gantt application 

automatically recalculates the dates of all the tasks that depend on it in order to take advantage of 

the time gained. Conversely, if a task is delayed, all the tasks that depend on it are automatically 

rescheduled, which may or may not impact the overall end date of the project. 

 

By using the Gantt display you can build and manage complete project plans in this standard, well-

defined format. You can easily add or remove tasks, set or adjust the duration of tasks (length of 

bars), link tasks (for example to make one task follow immediately after another), and add some 

constraints (e.g.: dependencies or specify that a task must begin no earlier than a given date). 

 

To help you get started, some Gantt applications include various ready-made project plans for 

common business activities (for example, organizing a tradeshow, producing a publication, 

launching a product). You can use these for training purposes or as a basis for your own project 

plans. 

 

Linking Tasks in a Gantt chart 

Project plans normally require tasks to be performed in a specific order. For instance, a publication 

must be written and proofread before it can be printed. To achieve this, the Gantt application lets 

you link tasks so that they depend on each other. 

 

By default, tasks are usually linked in a 'Finish to Start' relationship (dependency), which means 

that the first task you select (the predecessor task) must end before the next task you select (the 

successor task) can start, and so on. 

https://www.matchware.com/gantt-chart-software


This is typically represented on the Gantt chart by lines with arrowheads joining each task to its 

successor. The arrowhead indicates the direction of the link: it goes from the predecessor to the 

successor. 

 

 
 

Gantt chart multiple predecessors  

A task can have more than one predecessor. In this case its start date is determined by the 

predecessor link that gives it the latest start date. As dates and times change during the course of 

the project, the predecessor link that actually determines the start date of the task may change too. 

 

 
 

Gantt chart multiple successors  

Similarly a task can have several successors. In this case the task determines the start date of all 

its successor tasks. 

 

 
 

Gantt chart successors  

When you are scheduling a project plan from its start date the Gantt application calculates the end 

date of the project automatically, on the basis of the task durations, the task dependencies and the 

project calendar. 

 

The possibility of linking tasks in this way is what makes project management software particularly 

powerful: you can change the duration of one or more tasks, add a task or remove a task from a 

chain of linked tasks, and all the dates are recalculated automatically so as to maintain the task 

dependencies you have defined. 

 

Other Link Types 

There are four possible relationships (dependencies) between tasks: 

 Finish to Start (FS) - the default: The successor task cannot start before its predecessor 

ends, although it may start later. This is the most common type of relationship, and is 

described above. 

 Start to Start (SS): The  successor task cannot start until the predecessor starts, although 

it may start later. This can be useful if you have a task whose start date depends on the 

start date of another task. 

 Finish to Finish (FF): The successor task cannot end before the predecessor ends, 

although it may end later. 

 Start to Finish (SF): The successor task cannot end before the predecessor starts, 

although it may end later. This task relationship is rarely used. 

 

https://www.matchware.com/project-management-software


The following project plan for the preparation of a publication illustrates all these kinds of 

relationships: 

 

 
Gantt chart dependencies  

 

In this example: 

 The writing task follows on directly from the planning task. If the end date of planning 

changes, so will the start of writing. This is the normal Finish to Start relationship. 

 The editing task starts some way through the writing task. The writers and the editors work 

together as a team until the text is complete. Their tasks effectively end at the same time. If 

the end date of writing changes, so will the end date of editing. This is a Finish to Finish 

relationship. 

 The creation of artwork depends on the start of writing. In this case a lag (delay) has been 

introduced so that it doesn't start exactly when writing starts. Even so, if the start of writing 

changes, so will the start of artwork creation. This is a Start to Start relationship. 

 The final changes task depends on the end of artwork creation, but an overlap is included 

so that it actually begins two working days before the end date of artwork creation. If 

artwork creation is delayed, so will be the start of final changes. This is the normal Finish 

to Start relationship. 

 Printing starts after final changes are complete. This is also a Finish to Start relationship. 

 The transferring of paper from the warehouse to the printers must be complete in order for 

printing to start, but is not related to any of the preceding tasks. The printers have limited 

storage capacity and do not want the paper to arrive until it is needed ('just in time' or JIT 

scheduling), so the start of printing drives the delivery of paper. If the start of printing 

changes for some reason, so will the end date for getting paper to the printers. This is a 

Start to Finish relationship. 

 

Here each task has a single predecessor, the simplest arrangement. However, a task can have 

several predecessors. In such situations you will need to think carefully about possible undesirable 

consequences. For example, if you added another predecessor to the "Paper to printers" task 

above, it would be possible for that predecessor to push out "Paper to printers" so that its end date 

was later than the start of printing. 

 

Using Lag and Lead Times in a Gantt Chart 

When linking tasks you can add a lead or lag time to extend a link backwards or forwards so that 

the successor task starts earlier or later than it otherwise would. For a default 'Finish to Start' link, 

this either introduces an overlap (lead time), so that the successor task starts before its 

predecessor ends, or it introduces a delay (lag time) that makes the successor task start some 

time after its predecessor ends. 

 



When planning the production of a marketing brochure for instance, you could use lead time to 

make the creation of artwork start a few days before the writing phase is over. The two tasks are 

however still linked, which means that a delay of the writing phase will also delay the creation of 

the artwork. 

 

Adding Constraints to a Gantt Chart  (these constraints are not available in GanttProject) 

Constraints define the degree of flexibility available to the Gantt application when scheduling or 

rescheduling a task by imposing restrictions on its start or end date. The following task constraint 

types offer different degrees of flexibility. 

 

Two "constraints" are actually so flexible that they are not generally regarded as constraints at all: 

 As Soon As Possible (ASAP): This is generally the default constraint when you schedule 

your project from its start date, as is normally the case. You should try to keep this default 

whenever possible as it gives the software the most scheduling flexibility. If you apply this 

constraint to an unlinked task, the task will be scheduled to start at the project start date. If 

you apply it to a linked task, it will start as soon as the dependencies with its predecessor 

tasks will allow. 

 As Late As Possible (ALAP): This is generally the default constraint when you schedule 

your project from its end date. If you apply this constraint to an unlinked task, the task will 

be scheduled so that its end date coincides with the end date of the overall project. If you 

apply it to a task linked to a successor task, the task will be scheduled to end when the 

successor needs to start. On the whole, you should avoid this constraint as it does not 

leave any slack time to deal with possible problems. Any delay on the task is likely to 

impact the overall end date. 

 

The following constraints all restrict the Gantt application's flexibility when scheduling tasks. 

Although you might be tempted to use them if you are new to project management, you need to 

make sure you understand the implications. Keeping their use to a minimum (especially the last 

two) will allow you to take full advantage of the automatic scheduling possibilities. 

 

 Start No Earlier Than (SNET): This means that the task, whether linked or not, may not 

start before the given date. However, the Gantt application still has the flexibility to start the 

task later than the given date. 

 Start No Later Than (SNLT): This means that the task, whether linked or not, may not start 

later than the given date. However, the Gantt application still has the flexibility to start the 

task earlier than the given date. 

 Finish No Earlier Than (FNET): This means that the task, whether linked or not, may not 

end before the given date. However, the Gantt application still has the flexibility to end the 

task later than the given date. 

 Finish No Later Than (FNLT): This means that the task, whether linked or not, may not 

end later than the given date. However, the Gantt application still has the flexibility to end 

the task earlier than the given date. 

 Must Start On (MSO): This rigid constraint means that the task, whether linked or not, 

must start on the given date. Even if the preceding task is completed earlier, the Gantt 

application cannot pull in the constrained task to take advantage of the time gained. 

 Must Finish On (MFO): This rigid constraint means that the task, whether linked or not, 

must end on the given date. As above, even if the preceding task is completed earlier, the 

Gantt application cannot pull in the constrained task to take advantage of the time gained. 

 



If you decide to apply one of these constraints to a task, it is good practice to attach a note or a 

comment to the task to explain why you did so. If the constraint causes scheduling conflicts later 

on as your project evolves, you will be able to refer to the note to decide what to do. 

 

Such notes also allow you to distinguish easily between the tasks you have constrained yourself 

deliberately and the tasks you may have constrained inadvertently by moving their task bar or 

editing their start or end date manually. 

 

The effect of a constraint is not always obvious when you schedule your project plan from its end 

date, so take care to check that it does give the result you want. 

 

The following example shows some tasks in the preparation of a brochure for a mail shot. The mail 

shot is scheduled for September 10th. The tasks are linked, but we have set a 'Must Finish On' 

constraint on the printing task for September 7th, the latest date that will allow the mailing to go 

ahead on the following Monday, September 10th. 

 

The constraint, as usual, overrides the link. By setting a 'Must Finish On' constraint for September 

7th, we have effectively moved the task out so that it ends exactly on September 7th, regardless of 

whether it could have been completed earlier or not. 

 

 
 

Gantt chart constraints  

The problem with this is that if the printing task takes longer than expected, the mailing date will be 

missed. It would be much better to take advantage of the unused time after the end of the 

corrections task to get started with printing. However, we still need to keep an eye on the 

September 7th deadline. To do this, we remove the constraint from the printing task, so that the 

link will determine its start date, and add a deadline marker instead. 

 

 
Gantt chart deadlines  

 

Now there is a useful three day gap between the end of printing and the deadline, and the deadline 

is clearly indicated. The deadline indicator will warn us if the task moves past its deadline. 



Including resources in a Gantt chart 

Many Gantt applications allow you to assign resources to your tasks and project plans. Resources 

can be people, materials, equipment, budget amounts, or anything else. Typically, you might enter 

the names of people who will work on the tasks as resources. 

The Gantt display will indicate the resources that have been assigned to each task. You may also 

be able to enter additional information, for example: 

 Where the resource is a person or a team, the amount of time that the person or team will 

spend on the task. This is usually designated as a percentage, 100% signifying one person 

full time. So you would enter 250% for a team of three people where one of the people will 

be working only 50% of the time. 

 Where the resource is a material, the amount needed for the task. For a material such as 

sand it might be 50 tons. 

 The cost of the resource. In the case of a person this could be a dollars per hour figure. For 

a material such as sand it might be dollars per ton, for electricity dollars per kWh. 

 The rate of consumption of a material resource. Some resources have a fixed cost but for 

others the cost depends on the duration of the task. For example, heating might be 

estimated in kWh per day. 

 

Some Gantt applications will adjust the length of each Gantt bar (task duration) according to the 

amount of work the people assigned to the task can provide. Overuse of resources may be 

flagged, as when a schedule change makes two tasks involving the same team of people overlap. 

 

Enhancing a Gantt Chart 

Gantt applications generally include features to make your Gantt chart easier to use. These vary 

from application to application; here are some examples: 

 Adding explanatory notes to tasks. This is especially useful for tasks that have constraints. 

Constraints override links and can lead to illogicalities or schedule conflicts in the plan, so 

you will need to keep an eye on them. 

 Highlighting the critical path in order to see at a glance the tasks that are currently directly 

affecting your project end date. In a project plan, the critical path corresponds to the tasks 

or chain of linked tasks that cannot be delayed without delaying the entire project. A task 

lies on the critical path if a change to its start date or duration affects the end date of the 

project (or the start date if you are scheduling from the end of the project). Keeping a close 

eye on the status of your critical tasks at any time is therefore key to good project 

management. If the overall project duration is too long, the only way to make it shorter and 

bring in its end date is to shorten the critical path. 

 Setting milestones or deadlines to mark key dates. A milestone is a task with zero duration. 

It appears on the Gantt chart as milestone symbol. Milestones are generally used to 

indicate important dates on the project plan, often key events or goals. For example, you 

might use milestones to mark desired completion dates, or project review meetings. 

 

 
Gantt chart highlighting critical path  

 



A deadline marker does not affect any of the Gantt calculations, but places a visible marker on the 

Gantt chart as a reminder. In most Gantt applications an indicator will warn you if a task moves 

past its deadline marker. 

 

 
Gantt chart deadlines passing  

 

 Giving tasks priorities. 

 Showing a percentage completion for any task, visible on the task bar. 

 Customizing the appearance of the project plan on the Gantt chart, for example the color of 

task bars, the display (or not) of informational labels. 

 

Reviewing a project using a Gantt chart 

It's a good idea to review your project plan regularly in order to locate conflicts or other problems. 

You can then make appropriate changes to remove them. 

 

Here are some questions to ask yourself: 

 Is the project on course? View the end date of the last task on the Gantt chart. Check that it 

looks reasonable. 

 Has any task overshot its deadline? If so, you will need to take action: extend or remove the 

deadline, allow more time for the task or assign more people to it. 

 Are all the links between tasks necessary? By unlinking tasks that don't actually depend on 

each other, you will make use of all the slack time available, thereby shortening your 

schedule and maximizing its flexibility. 

 Consider whether some tasks could overlap each other to reduce the overall duration of the 

project. If so, assign appropriate lead times (see Using lag and lead times in a Gantt chart). 

Another possibility is to redefine some of your 'Finish to Start' relationships to either 'Finish 

to Finish' or 'Start to Start' if the logic of your schedule allows it. 

 Are the constraints working as you expect (not in GanttProject)? If you have been adding 

an explanatory note to every constraint you set, read the notes to check that your intentions 

are still being met. And look for tasks that have a constraint but no note: these may have 

been created inadvertently and be causing trouble. Also, because constraints generally 

override links, they can introduce schedule conflicts. 

 Do the tasks that have constraints fall where you expect them to? Do they fit logically with 

the other tasks around them? Checks that their start and end dates are neither too early nor 

too late. 

 Are there unexpected overlaps or gaps between linked tasks? Often this is caused by a 

rigid constraint on one or other of the tasks. However, remember that overlaps and gaps 

can also be caused by intentional lead or lag times. 

 

  



Source:  GanttProject forum  

 

GanttProject: Using milestones 
 

It is common in project management to confirm that intermediate goals have been reached.  These 

goals may be presented in a Gantt chart as summary tasks.  Using milestones (i.e. deadlines), 

notably at the end of summary tasks, facilitates progress monitoring.  

 

 A milestone is created in a project as a configured task.  It appears on the Gantt chart as a 

diamond marker.  It can also be configured to display a label showing the task name, 

immediately above the timeline in the Gantt chart. 

 A milestone has zero duration, although Task properties show it as having a duration of 1.  

This cannot be changed. 

 Clicking on a label causes the corresponding task in the Gantt data table to be highlighted.  

This can make it easier to find the task in a large project. 

 

 
Milestone (red) day started on Gantt chart with label above timeline 

 

 

Set a task as a milestone: 

1. On the Gantt view, select the task 

2. Right-click on the task 

3. Click Task properties… 

4. In Task Properties, near the top, check 

Milestone 

5. Click Ok 

 

Display the label above the timeline 

1. On the Gantt view, select the task 

2. Right-click on the task 

3. Click Task properties… 

4. In Task Properties, near the bottom, check 

Show in timeline 

5. Click Ok   



Source:  various fragments  

 

GanttProject: Summary tasks and subtasks 
 

Start with a WBS process – end with a Gantt table 

To begin, we will build a simple Work Breakdown Structure (WBS), a plan for a work day  

 For a start, we describe the three phases of the day, shown in the left column below.  

 These phases need to be expanded upon by the tasks in the second column.   

 The actual WBS integrates the first two columns, using outline numbering.  

 In the Gantt data table the task names would look like the fourth column.  

 

Project: A work day 

Phases Tasks WBS Gantt table names 

Start the day  1.0 Start the day 
1.1 Get up 
1.2 Take a shower 
1.3 Eat breakfast 
1.4 Go to work 
2.0 Run the business 
2.1 Open the doors 
2.2 Sell things 
2.3 Close the doors 
3.0 Finish the day 
3.1 Go home 
3.2 Eat dinner 
3.3 Watch TV 
3.4 Go to bed 

Start the day 
 Get up 
 Take a shower 
 Eat breakfast 
 Go to work 
Run the business 
 Open the doors 
 Sell things 
 Close the doors 
Finish the day 
 Go home 
 Eat dinner 
 Watch TV 
 Go to bed 

 Get up 
Take a shower 
Eat breakfast 
Go to work 

Run the business  

 Open the doors 
Sell things 
Close the doors 

Finish the day  

 Go home 
Eat dinner 
Watch TV 
Go to bed 

 

All of the actions in the plan, phase or specific, are called tasks. 

The phase tasks are called summary tasks. 

Tasks that give detail to a summary task are sometimes called subtasks, or even child tasks. 

 

When the list of tasks is entered in the name data column of a Gantt view:  

 For clarity, subtasks should be kept in execution order   

 Each summary task must be followed immediately by its subtasks 

 A task may be indented by either one or two levels 

 A summary task is created by indenting at least one following subtask  

 If all its subtasks are deleted, a summary task reverts to being a plain task 

 If a summary task is deleted, its subtasks are also deleted 

 

How to indent 

 The indent level of linked tasks cannot be changed 

 To indent a task, right-click on the task > Indent 

 To reverse the indentation, right-click on the task > Unindent 

 

Summary details 

The details of a summary task (Start date, End date, duration and Cost) are computed from the 

combined contribution of its subtasks.  Entering these details directly in Task Properties of the 

summary task is likely to create errors.  

 

To show or hide all subtasks of a single summary task, simple click the expand/collapse button 

found on the left of the summary task name.  This will toggle the current state.  



Source:  various fragments  

 

GanttProject: Task types 
 

See also GanttProject: Summary tasks and subtasks 

 

Tasks play a range of types in a Gantt chart.  The types are: 

 Project summary 

 Summary  

 Task  

 Milestone  

 

Each type of task has its own symbol on the Gantt timeline, as shown in the screenshot below, 

taken before creating any links.  Note the three possible indent levels. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A milestone task shows where a deadline occurs.  It must be 

a simple task, not a summary.  It is created by ticking the 

Milestone box at the top of the Task Properties dialog box.  A 

milestone task has a 0 (zero) duration, although it is shown as 

1 (one) in Task Properties. 

 

A plain task is used to show durations, links and sequence of a series of tasks.  It is created with 

the New Task right-click option in the Gantt data table. 

 

A summary task identifies a group of closely related tasks.  It is created by indenting the group of 

tasks immediately below it.  The group may include lesser summary tasks.  It is  best not to link 

summary tasks, but to link directly to their component tasks.  Similarly, resources are best 

allocated to component tasks. 

 

A project summary task is usually the top-level task 

of a project.  It is created by ticking the Project box at 

the top of the Task Properties dialog box.  The only 

difference of a project summary is that its symbol has 

a thicker bar.  More than one summary in a project 

can be a Project summary, but only if they are at the 

same indent level. 


